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Having our students become proficient in the use of technology is an important

aspect to helping all students become successful.  

Microsoft Office 365 contains many useful features to help our students with their

learning.  It is not simply just a way to make writing neater or to publish an

assignment.  

Teaching our students about the learning tools that technology offers us can

help make learning accessible for all.

The lessons that are included in this unit cover the following ADST Competencies

(Applied Skills)

These lessons are designed to be student self-directed.



In the "Files" pane,

click "OneDrive"

In "OneDrive",

click "+New"

                On the left side

                of the TEAMS

window, click "Files"

(You may need to click

the ... below to find files)

MAKING A NEW WORD

DOCUMENT SD57
To protect your information in Office 365, School District 57 has not placed Word

on the Home Page of your account.  Log in to your Office 365 account.

TEAMS

Name: ______________

Teacher: ____________

Date: _______________

On the Home Page, click the "TEAMS"

app, found on the left side of the page.

Name and Create

your document
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1.The Ribbon is at the top of your page and allows you to use different

commands to complete your task. 

2. There are 8 tabs at the top of the ribbon. Each tab has a specific group of

related commands. Write the names of the tabs below.

________, ________, ________, ________, 

________, ________, ________, ________

3. Within each tab, there are different sections that group commands together.  

The names of the sections are written at the bottom of the ribbon and are

separated by vertical lines.

In the "Home" tab, there are 9 sections.  Write the names of the sections below.

________, ________, ________, ________, ________, 

________, ________, ________, ________

4. In each section, there are buttons that do specific tasks.  If you hover your

mouse over the button, a pop up will tell you what each button does.

                       Sometimes, there are arrows beside the button.  This brings up a

                       drop down list of more specific tasks.

In the "Home" tab, "Font" section, list the 5 buttons that have drop down lists.

________, ________, ________, ________, ________, 

INTRODUCTION TO

WORD
Word for the web (included in Office 365 accounts, is a powerful tool to help you

with your learning.  Log into your Office 365 account and open up a word

document.

key vocabulary

Name: ______________

Teacher: ____________

Date: _______________
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I can identify a tab 

I can identify a section

I can identify a drop down list

Checkin
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This is the language that you want to write in and the language that the

program will check your spelling and grammar with.

In the bottom left corner of your blank document, click on "English (U.S.)"

Set your proofing language (usually to English (Canada) or French (Canada)

Font is the style of letters and size is the size your words will print on the page.

Select a font that works for the theme of your document and use it for the entire

document.  Common fonts are Times New Roman, Arial, and Calibri.  Common

size is 12.  

Set your font: "Home" tab, "Font" section, "Font Name" button.  

Set your font as "Times New Roman" 

Set your font size:  "Home" tab, "Font" section, "Font Size" button.

Set your font size as 12.
 

SETTING UP A 

WORD DOCUMENT
After opening a new document, the first thing you should do is to set up your page.

Proofing language

font and size

Name: ______________

Teacher: ____________

Date: _______________
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Sometimes it is very hard to read the words on the page and we need them to

be bigger.  

Rather than increase the font size, (which changes the size the words will print)

use the Zoom button on the bottom right of your page.  

I can set the proofing language 

I can change the font

I can change the size

I can zoom in and zoom out

Zoom in and out

Checkin

                      6                                                                              SD57 (Prince George)



After setting up your page, you are ready to begin typing!

Before you begin this assignment, have a topic that you will write about.  You can:

            Choose your own topic ______________________________________________

            Use the topic provided by your teacher ________________________________

            Use "The Grossest Meal I've Ever Eaten"

Alignment
Alignment means how your words will line up on a page.  To change the

alignment of text on the page, go to "Home" tab, "Paragraph" section.

TYPING IN A 

WORD DOCUMENT

Name: ______________

Teacher: ____________

Date: _______________

When we write, every line usually starts on the left of the page. 

 This is called left align.  Find the left align button (by hovering

your mouse over the buttons)  Draw what the left align button

looks like.

When we write a title, we want it to be centered across the page. To do this, you

want to center align. Find the center align button (by hovering your mouse over

the buttons). Draw what the center align button looks like below.

TASK

Type your 

title center 

aligned.  

DO
 NO

T PR
ES
S TA

B

OR
 SP
AC
E BA

R TO

MO
VE

 YO
UR

 W
OR
DS

TO
 TH

E CE
NT
ER

 OF

TH
E PA

GE
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Bold means to make the letters darker to have them stand out.

Underline means to make a line under the word.

Italicize means to make the letters slant to the right to have them stand out.

These text features are found in "Home" tab, "Font" section.  Find the Bold,

Underline and Italicize buttons (by hovering your mouse over the buttons)

Draw what each button looks like

       Bold                                                   Underline                                                     Italicize 

Spacing means the amount of space between each line.  

This is found in "Home" tab, "Paragraph" section.  Find the "Line Spacing" button

(by hovering your mouse over the buttons)

What are the 6 default 

line spacing options?

                ____

                ____

                ____

                ____

                ____

                ____

spacing

Hint:  If you have already typed your title, you can

"select" the words you want to bold by moving your

mouse to the beginning of the word, clicking and

holding the left mouse button, and dragging the mouse

over the word(s) you need.  The words will turn grey. 

 You can now select bold and underline and those

words will change.  

bold, underline, italicize

TASK 

Make your

title bold
and

underlined.

TASK 

Change

your line

spacing to

1.5 lines.

                      8                                                                              SD57 (Prince George)



Starting a new paragraph: press enter to get to a new line

Indent:  press tab on the keyboard once 

Capitals:  press and hold shift key and letter

Spacing: use one space between words and

                         after end punctuation

typing basics

DO
 NO

T PR
ES
S SP

AC
E

BA
R TO

 M
OV
E YO

UR

CU
RS
OR

 OV
ER
!)

Title (center aligned, bold, underline)

Line spacing set to 1.5 lines

Paragraph left align

First line indented

Writing about topic completed with

capital letters, punctuation and word

spacing

if you have been following along with the

tasks in this lesson, you should have

completed the following steps:

1.

2.

3.

4.

5.

TASK

SUMMARY

TASK 

Start a new

paragraph

and indent. 

 Begin

writing!

Check in

I can change the alignment

I can change the line spacing

I can indent

I can make capital letters and use

correct word spacing
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I want to write the word "beautiful".  I am not sure how

to spell it correctly, so I do my best with writing the

sounds that I hear.  

       Type the words:  beutiful life (exactly like that).

        Describe below what Word did to beutiful.

       Type the words: beeutiful life (exactly like that).

       Describe below what Word did to beeutiful.

Guess what word you were trying to type and change it automatically

Write the letters that you typed and underline the word in red.  This tells you

that Word does not recognize this word in its dictionary.

To allow Word to check your spelling accurately, you will need to have set your

proofing language to the language that you are writing in. 

As you type, Word constantly reads what you are writing and checks your words in

its dictionary.  If you type a word that is not in its dictionary, it will do one of two

things:

1.

2.

Word has the ability to check your writing for spelling errors and correct grammar.  

This can be done during and after you type.

Before you begin this assignment, open a new word document.

SPELLING/GRAMMAR 

IN A WORD DOCUMENT

spelling

Name: ______________

Teacher: ____________

Date: _______________

TRY 

THIS

Notice that beeutiful is underlined red.  To change the spelling,

hover your mouse over top of the word and click the left mouse

button.  A list of suggestions will appear.  Read the suggestions

carefully, and IF the correct word is there, click on it.  The correct

spelling will appear on your page.

                      10                                                                              SD57 (Prince George)



To allow Word to check your grammar accurately, you will need to have set your

proofing language to the language that you are writing in. 

As you type, Word constantly reads what you are writing and checks your words to

see if you are using them correctly.  

If what you are writing does not make sense, Word will underline that part in blue.  

Type this sentence exactly as it is written.

The brown fox have a beautiful life. 

Describe what Word did.

GRAMMAR

TRY 

THIS

Notice that have is underlined blue.  This tells you that you have used the wrong

word.  In this case, it is the wrong tense of the verb.  

Hover your mouse over the word and click the left mouse button.  A list of

suggestions will appear.  Read the suggestions carefully, and IF the correct word

is there, click on it.  The new word will appear on your page.

TASK

Open a new document and begin typing a story or open an

existing document.  Check to make sure that there are no

spelling or grammar errors.  There should be no red or blue

underlining in any of your typing.

Check in

I can use spell check

I can use grammar check
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When the microphone is red in the pop up

window, it means that the microphone is on

and word will write out what you say.

You may have to

allow your

computer to 

access the

microphone

Click the

microphone to

turn it off or on.

A pop up window will appear

near the bottom of the page.  

USING DICTATE 

IN A WORD DOCUMENT
Dictate is an app built into Word for the web.  It will type out anything that is

spoken onto the page.  Log into your Office 365 account and open up an existing

or new Word document.

dictate

Name: ______________

Teacher: ____________

Date: _______________

Dictate is found in the "Home" tab, "Dictation" section.  Click on the microphone

button.

You will need to speak clearly so the computer will be able to understand your

words.  Sometimes, if your speech isn't very clear or there is lots of noise, it will

write the wrong word or words!
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You can adjust how the

computer interprets your words.

settings

You can change the

language that you are

speaking, so that the

computer will predict

your words correctly.

You can have the

computer automatically

put punctuation into your

speech.  

Sometimes, especially

if you pause to think,

the computer will think

you ended the

sentence and put

periods in where you

don't need them!

If you disable auto-punctuation,

what the computer writes will be a

long sentence with no periods.
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With practice, you can control

what the computer does with

your voice.  

You can say things like "delete

that" and it will delete the word

you just said, or "next line" and it

will skip down and begin writing

on the next line.

dictate help

TRY

THIS

Click into "Dictate".  Be sure your language is set to

English (Canada) and have punctuation enabled.

Speak the following words into the microphone.

"Once upon a time there were three little pigs who
lived with their mother. One day their mother told
them they were old enough to go out into the
world and make a living for themselves."

Try to get dictate to write out exactly what is written,

complete with punctuation.  
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I can open Dictate

I can change the language

Checkin
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A pop up window will appear

with all of the words in the

document.

Press the "Play" button at the bottom to

have Immerive Reader begin reading to you

Change the Voice Speed and

Voice Selection (Male or

Female)

USING IMMERSIVE READER 

IN A WORD DOCUMENT
Immersive Reader is an app built into Word for the web.  It will read aloud anything

that is written on the page.  Log into your Office 365 account and open up an

existing or new Word document.

IMMERSIVE READER

Name: ______________

Teacher: ____________

Date: _______________

Immersive Reader is found in the "View" tab, "Document Views" section.  Click on

the "Immersive Reader" button.
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Within Immersive Reader, there

are 3 "Preferences" in the top

right of the page.  These

buttons allow you to customize

how Immersive Reader works

for you. 

preferences

Text preferences

Tex Preferences allows you to change how the

text appears in the Immersive Reader window.  

You can increase or decrease the size of the

letters (font)

You can increase or decrease

the spacing of the lines to

make it easier to read

You can change the font to one of 3 fonts

You can change the Theme. 

 This changes the background

colour and the colour of the

font to make it easier to read.
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Grammar Options

allows you to have

different parts of

speech shown in the

Immersive Reader

window.  

You can have

words broken up

into syllables to

have them easier

to read

You can change

colours.  This will

change the

colour of the font

for each part of

speech to that

colour.  This

allows you to

easily identify

different types of

words.

You can toggle

parts of speech

on or off.

Grammar options
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Reading Preferences allows you

to customize the way the print

appears to you in the Immersive

Reader window.  

You can have the words

translated into 100's of

languages.  This only

changes it in the Immersive

Reader window.

You can toggle line focus on

or off and then select the

number of lines that appear

on the page at a time.  This

helps your eyes track from

line to line more easily.

reading preferences

Picture dictionary shows a

picture when you click on a

word to help you understand

that word.

If you click on a

word, the translation

for that word will

appear, and you can

have it read to you. 

The entire document

will be translated,

and you can have it

read to you. 
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TRY

THIS

 Change the text size to 48.

Change the theme to black print with

a yellow background.

Change the line focus to single line.

Experiment with translate into another

language, with word and document

options.

Change the voice to female

Use Immersive Reader.  You may type

sentences into a new document or use a

document you have already typed in. 

 Experiment with the different features to

determine what works best for you.

1.

2.

3.

4.

5.

When using Immersive Reader, these are the preferences that work best for me:

Voice Selection: ________________                   Voice Speed: ___________________

Text Size: ______________________                   Theme: _________________________

                                      Line Focus _____________________

I can open Immersive Reader

I can set the preferences that work

best for me

I can use the translate feature

Checkin
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PICTURES IN A WORD

DOCUMENT
Adding pictures to your projects is a great way to make them more visually

appealing.  

Log into your Office 365 account and open up a word document.

Inserting pictures

Name: ______________

Teacher: ____________

Date: _______________

To add a picture to your page, go to the "Insert" tab, "Picture" section and click the

arrow on the button.  

You can insert a picture from your device

(one that you may have saved before), from

your OneDrive (cloud-based storage in Office

365), stock images (from Word) or search for

one on the internet.

Search for pictures of monkeys on the internet

using "Bing Pictures".  

When you find one that you like, select the picture

by clicking on it, and then click "Insert".  Your

picture will appear on your document where your

cursor is.

TRY

THIS

Your picture may not be in the place where you want it to be.  You need to format

your picture!  

                                 Select your picture by clicking on it.  

                                 A box with dots will appear around your picture.  

                            A NEW tab will appear called "Picture".  Click on the "Picture" tab.

                      21                                                                              SD57 (Prince George)



Green border

3 pt weight

dotted line

Rotate upside down

Wrap Text Square Right

Select your monkey picture by clicking on it. 

 Go to the "Picture" tab

Format your picture:

TRY

THIS

You can also resize your picture by clicking on the dots ont he border of the

picture and dragging your mouse in or out.

                                              You can rotate your picture by clicking on the arrow circle 

                                              on the border of the picture and moving your mouse.

 

Put a frame around the picture

Put a border around the picture (can change the colour of the line, the

thickness (weight) of the line, and the style (solid, dashed etc)

Rotate the picture

Set where the picture will be on your page in relation to the text (wrap text)

Crop the picture (cut out parts of the picture)

Change the size of the picture

In the "Picture" tab, the sections allow you to change your picture.  

You can:

formatting a picture

There are more features for formatting pictures when 

you use the desktop app of Word.  To get to the desktop 

app, click the "Editing" button on the ribbon.  

If this is the first time you have done this, you may be

prompted to download the app.  

**Adding text boxes is only available through the desktop app.  
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Check in

I can insert a picture

I can put a border around my picture

and change the colour and line style

I can rotate my picture and change

the text wrap

I can open the desktop app
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Common bullet symbols are:

                    dots

                    check boxes

                    check marks

                    stars

                    X's

BULLETS AND LISTS IN

A WORD DOCUMENT
Using bullets and lists is a great way to draw attention to information in your

document.  Log into your Office 365 account and open up a Word document.

bullets

Name: ______________

Teacher: ____________

Date: _______________

Bullets are symbols that are used before a word or a phrase in a vertical list.  

TRY

THIS

To make a bulleted list, in the "Home"

tab, "Paragraph" section, click the

arrow beside the button with 3

vertical dots. 

                                                                            Click the arrow beside the bullet button

                                                                            and select a bullet type.

                                                                             Type the word "soccer" and press enter.

Another bullet will appear on the new line.  Type "hockey" and press enter. 

 Continue typing 4 more sports in a bulleted list.  

When you no longer want the bullet, press backspace to bring your cursor to the

left margin.
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To make a numbered list, in the

"Home" tab, "Paragraph" section,

click the arrow beside the button

with 1, 2, 3 vertically.  

Numbered lists

Another way to organize information is to make a numbered list.  A numbered list

usually orders information according to importance, or, is used to clearly show the

number of items in a list.

TRY

THIS

Make a 6 item numbered list 

of your favourite foods.

                                                                          

A list of numbering styles

will pop up.  Select the

style you want.  

The first number or letter

will appear on your page. 

 When you press enter, the

next in the series will

appear.  

When you are finished,

delete the last number or

letter to bring your cursor

to the left margin.

Check in

I can make a bulleted list

I can make a numbered list
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To make a new table, go to the "Insert" tab, "Table" section.  

Click on the arrow below the table.  Drag your mouse over 

to select the number of columns (vertical lines) and down to 

select the number of rows (horizontal lines).  

                                                You will see a number at the top that says

                                                how big your table will be.

Ex:  4x2 means 4 colums and 2 rows

TABLES IN A 

WORD DOCUMENT
Tables are a great way to organize information into horizontal rows and vertical

columns.  Log into your Office 365 account and open up a Word document.

making Tables

Name: ______________

Teacher: ____________

Date: _______________

TRY

THIS

Make a table that has 2 columns and 6 rows

writing in Tables

To type information into a table, click in the cell (box) that you want to type in.  

You can format the font and font size of the typing in a 

table by selecting the cells you want to format and then 

go to "Home" tab, "Font" section.  Formatting the font in 

a table is done the same way as usual.                                                
Be

 su
re to

 "se
lec
t" th

e

ce
lls 
by

 hi
gh
lig
hti
ng

the
m wi

th yo
ur 
mo
use

.
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You can continue writing information in a table, in rows and columns, but clicking

into the cell you need.  

If you need more columns or rows, you can add them by clicking the cell near where

you want to add rows or columns.  Go to the "Table Layout" tab, "Insert" section, and

select the button to add a row above or below, or a column left or right, from your

cursor.  

You can delete columns or rows by highlighting the row or column you wish to

delete, go to the "Table Layout" tab, "Delete" section and select the button to delete

a column or row. 

TRY

THIS

In your table, type "Favourite Animal" in Row 1, Column

1, and "Number of Students" in Row 1, Column 2.  

Change the font and size of the typing in your table 

to Times New Roman 12.  Make the typing in Row 1

centred and bold.  

writing in Tables

TRY

THIS

In your table, type the following information into the

correct column.  

24 students said dogs were their favourite animal

while

23 students said cats were their favourite animal.  14

students liked horses, 19 students liked chickens and

only 5 students said their favourite animal was a pig.

Remember your typing should be left aligned and in Times New Roman 12.
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You can add shading or colour to your table to highlight cells, rows or columns. 

Select the cell or cells that you wish to shade and go to "Table Design" tab,

"Shading" section.  Click the arrow beside the "Cell Shading" button and select the

colour that you want.   

borders in tables

IYou can also change the colour of the table border.  

Select the cell or cells that you wish to change and go to "Table Design" tab,

"Borders and Shading" section. Click the arrow beside the "Border Colour" and

select the colour you want.

Shading in tables

You can change the weight (thickness) of the borders in a table.  

Select the cell or cells that you wish to change and go to "Table Design" tab,

"Borders and Shading" section.  Click the arrow beside the "Border Selection". 

 From here you can select which lines you want, the weight (thickness) and the

style of the line.  You can also remove the border.   
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TRY

THIS

In your table, shade Row 1 green.

Change all of the border lines to weight 3.  

Check in

I can insert a table

I can change the font, size and

alignment

I can add shading

I can change the border
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You can share your Word document easily with others.  

Click on the "Share" button in the top right of the ribbon.  

Click the arrow beside "People you specify

can view".  The default setting is "Specific

People" which means that only those who

you name can see the document.  

If you want the person or people you specify

to be able to edit or change the document,

then click allow editing. 

Click Apply.

You can decide who will be able to see your

document and if they will be able to just view it

or if they will be able to edit (change) it.  

SHARING A 

WORD DOCUMENT
Word allows you to share a document with other Office 365 users. This is a great

way to collaborate with a classmate or to share a document with someone to read.   

Log into your Office 365 account and open up a Word document.

Name: ______________

Teacher: ____________

Date: _______________
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You can type

the name of

the people

who you

want to share

the

document

with.  
You can write

a message to

them

TRY

THIS

Share a document with a friend by typing their

name into the "Share" screen.  Allow them to edit

it.  Together, try writing a few sentences to see

how collaborating on a document might look.

Click Send and Word will

send a message to their

email in Outlook

In my document, I can see who it is shared with.  The

initials of the person will appear in a bubble beside the

"Share" button on the ribbon.  If it is shared with more

than one person, there will be more than one bubble.

I can also see who is

typing.  A coloured symbol

will appear as their cursor.
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Check in

I can Share a document with a

specific person

I can allow a specific person to edit

a document

I can collaborate on a document
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